CHAPTER 10
                    MIDNIGHT COMMANDER

10.1 mc NEDİR?

Midnight Commander, hem Linux, hem de çok kullanılan diğer Unix türevi işletim sistemlerinde çalışabilen  text tabanlı bir dosya yöneticisidir.
Midnight commander, unix – tipi sistemler için görsel kabuktur. Aynı zamanda dosya ve dizin tarayıcısı ve yetenekli bir dosya yöneticisidir (File Manager). 
mc ‘nin ekranı dört ana parçaya  bölünmüştür. Ekran alanının hemen hemen çoğunluğunda iki adet panelle doldurulmuştur. Ekranın alttan ikinci satırı komut satırı olarak ayrılmıştır ve altındaki satır ise fonksiyon tuşları etiketleri ile  görsel yardım sağlayan nitelikte bir görüntü sergiler. 
Midnight Commander kurulumu, Linux kurulumu esnasında yada rpm paketlerinden sistem kurulumu sonrasında gerçekleştirilebilir. Rpm paketinden kurulum bilinen şekilde gerçekleştirilir. RedHat/Fedora paketinde kurulumu aşağıdaki gibidir.
$ rpm –i mc-4.6.51-32.i386.rpm     
Başlatmak için yapmanız gereken sadece 

[root@localhost root]# mc

yazıp "Enter" tuşuna basmak olacaktır. Eğer Görsel Arayüzde iseniz önce bir terminal açacaksınız.

mc sağ ve sol olmak üzere iki panelden oluşur. Bu iki panel arasında dosya transferi yapmak oldukça hızlıdır, mc ilk başlatıldığında daha önceden bir işlem yapılmamışsa sağ panelde kök dizini, sol panelde ise kullanıcının ev dizini bulunur.

mc ile çalışırken aynı zamanda komut satırından istediğiniz komutları da çalıştırabilirsiniz. Ancak buna çoğu zaman ihtiyacınız olmaz.

10.2 YAPILANDIRMA

mc'nin temel yapılandırmasına girmek için "F9> Options > Configure" yolunu izleyin. Karşınıza yapılandırma seçenekleri gelecektir. Seçenekleri işaretlemek için ok tuşları ile ilerleyip, seçeneğin üzerine geldikten sonra boşluk çubuğuna basabileceğiniz gibi, sarı büyük harflerle gösterilen tuşlara basarak da işaretleyebilirsiniz. Aslında bu yapılandırmaları açıklamaya gerek yok, çünkü her şey açık seçik belli. Türkçe olarak açıklamalar aşağıdadır.
• show Backup files: Yedeği alınan dosyaları gösterir.
• show Hidden files: Gizli dosyaların görünmesini sağlar. UNIX işletim sisteminde gizli dosyaların nokta (.) ile başladığını unutmayın.

• maRk moves down: İşlem yapacağınız dosya (ya da dizinleri) seçmek için "Insert" tuşunu kullanabilirsiniz. Bu seçenek işaretlendiyse, "Insert" tuşuna her basışınızda dosyaların seçilmesi aşağı doğru devam eder.

• Drop down menus: Başlangıçta bu seçenek işaretli değildi ve biz F9 tuşuna bastığımızda sadece menü çubuğu aktif hale gelmişti. Her menünün alt menülerini görüntülemek için bir de fazladan aşağı doğru ok tuşuna basmak gerekiyordu. Seçenek işaretlenirse bundan kurtulursunuz. Yani F9 tuşuna basar basmaz alt menülerde aktif hale gelir.

• miX all files: Bu seçenek işaretli değilse, önce dizinler, ardından da dosyalar sıralanır (paneldeki sıralama seçeneğine bağlı olarak). Ancak dosya ve dizinlerin karışık olarak sıralanmasını istiyorsanız burayı işaretleyin.

• Fast dir reload: Sağ veya sol panelde görünen bir yerde mc dışında bir değişiklik yaptıysanız (örneğin dizin yada dosya silip oluş-turduysanız) bunları görmek için "Ctrl-r" tuş takımına basarak dizinin yeniden gözden geçirilmesini sağlamalısınız. Bu seçeneği seçerseniz, otomatik olarak tüm değişiklikler aynı anda görüntülenir.

• Pause after run: Komut satırından bir program çalıştırırsamz (örneğin ls) sonucun görüntülenmesi ile ilgili seçenekleri belirtir. Eğer burası "Never" yapılmışsa komut çalıştırılır ve hemen tekrar mc'ye dönülür. "alwaYs" işaretliyse komut çalıştırılır ve sonuç ekranda görüntülenir. Siz herhangi bir tuşa basıncaya kadar mc'ye geri dönülmez.

• Verbose operation: Kopyala, silme ve yeniden adlandırma işlemleri yapılırken komut çalıştırılmadan sizden onay alınmasını sağlar. Bu seçenek işaretli değilse onay alınmadan hemen komut çalıştırılır. 
Şimdi, önemli gördüğümüz birkaç seçeneğe bakalım:
• Use internal editor: Bu seçenek işaretli olursa, metin dosyalarını düzenlemek amacı ile "F4" tuşuna bastığınızda mc'nin kendi metin düzenleyicisi kullanılır. 
• Safe delete: Dolu dizinler silinmeye çalışıldığında fazladan bir onay istemi gerektirir.

Diğer Seçenekler: Layout

Diğer seçeneklere bir göz atalım. Hemen "Layout11 alt menüsüne gelin. Bu menüye ulaşmak için "F9 > Options > Layout" yolunu izleyebilirsiniz. Burada sadece Panel ayırma seçeneklerine bakacağız. Seçenekler Şekil-l'te görünmektedir.
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Şekil-1: Pencerenizi ister boyuna, ister enine ayırın.

Bazı kullanıcılar boyuna değil enine yanmayı sevebilirler. Bunun için "Horizontal" seçeneği işaretli olmalıdır. Eğer pencereyi tam ortadan değil de isteğinize göre ayırmak istiyorsanız "[<]" veya "[>]" seçeneklerine gelerek "Enter" tuşuna basın ve dilediğiniz bir ayarda bitirin. Şekil-2'te enine ve alt taraf küçük olacak şekilde ayrılmış panelleri görüyorsunuz.
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Hint: Vant your plain shell? Press C-o,
[rootlsnc_eccl§

and get back to IC with C-o again.
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Şekil-2 Farklı bir ayırma yöntemi

10.3 mc'Yİ ARTIK KULLANABİLİRİZ

Sol ve sağ panel ayarları ayrı ayrı yapılanabilmektedir. Şimdi önemli gördüğümüz birkaç ayarı sadece sol panel için yapalım. Aynı yapılandırmalar sağ panel içinde geçerlidir. 
• Quick View: Bu seçeneğe gelirseniz, diğer panelde hangi dosya üzerinde iseniz o dosyanın içeriği görüntülenecektir. Şekil-3'de sağ paneldeki passwd dosyasının içeriği sol panelde görünmektedir.
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Şekil-3: Sürekli dosyaların içini izlemek isteyenlere
• Info: Dosya ve dosyanın bulunduğu dosya sistemi ile ilgili tüm detayların görüntülenmesini sağlar. Şekil-4'te ilginç bir yapılandırma görünüyor.
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Şekil-4: Dosya Bilgileri
• Tree: Eski DOS kullanıcıları dosya sisteminin dizin yapısını görmek için "tree" komutunu kullanırlardı. İşte aynı işi yapmak için bu seçeneği kullanabilirsiniz. Sol panelde dizin yapısı ve sağ paneldede aktif dizinin içeriği görünüyor.
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Hint: You may specify the external viever with the shell varisble PAGER.

[root@snc X11]1#
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Şekil-5: Windows benzeri bir mc yapılandırması. Sol tarafta dizinler, sağ tarafta içeriği 

• Sort Order: Dosya ve dizinlerin sıralanışını buradan ayarlayabilirsiniz. Şekil-6'da tüm seçenekler görünüyor. Şimdi bunları kısaca açıklamaya çalışalım (Açıklamalarda seçenek-lerdeki harfler kullanılmıştır)
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Şekil-6: Dosya Sıralama Seçenekleri

U: Disk üzerine nasıl yazıldıysa tüm dosyalar o sırada görüntülenir, herhangi bir sıralama yapılmaz.

N: İsme göre sıralama yapılır.

E: Dosya uzantısına göre

M: Son düzenleme tarihine göre

A: Son erişme tarihine göre

C: Son değişiklik yapma tarihine göre

S: Dosya büyüklüğüne göre

I: Inode'a göre.

R: Tersten

t: Sıralamada büyük küçük harf duyarlılığı yapılır.

10.4 mc İLE FTP

Linux'ta birçok ftp istemcisi vardır. Bunlardan en kullanışlısı olarak gördüğümüz ise mc'dir. 
mc ile uzaktaki ftp dosya sistemi sanki yerel dosya sistemi imiş gibi yapılır, ftp yapmak için hemen bulunduğunuz panelde "F9" tuşuna basarak "Ftp link" seçeneğine gelip "Enter" tuşuna basın. Gelen satıra istemci olacağınız makinedeki e-posta adresinizi yazın. Eğer "Anonymous" istemci olacaksanız sadece makinenin IP veya ismini yazın. Şekil-7'de mbaser kullanıcısı gelecek.com.tr makinasına istemci olmaya çalışıyor.

[image: image7.jpg]FIP. to naghisis
Enter nachine nane (F1 for details):
nbaser@gelecek,con,trll

< k>3 [ ancel 1







Şekil-7: mc: iyi bir FTP istemcisi

Bunu yazıp "Enter" tuşuna bastınızda sunucu ile bağlantı kurulmaya çalışılacak, eğer başarılırsa kullanıcının parolası sorulacaktır.

10.5 DOSYA VE DİZİN İŞLEMLERİ

	 [image: image8.png]



	Not: Bu bölümde tek dosya (veya dizin) üzerinde açıklama yapacağız. Eğer aynı işlemleri birden fazla dosya veya dizin üzerinde yapmak istiyorsanız o zaman bunları seçin. Seçmek için "Insert" tuşunu kullanabilirsiniz. Bulunduğunuz yerdeki tüm dosyaları seçmek için (nümerik klavye üzerindeki) "+" tuşuna, seçimi iptal etmek için " -" tuşuna basabilirsiniz. Özel seçim yapmak için uzantı yada önek kullanabilirsiniz. Örneğin tüm "jpg" uzantılı dosyaları seçmek için "+" tuşuna bastıktan sonra gelen satıra "*.jpg" yazmanız yeterlidir.




Bir dosya yöneticisinin temel işlerinden birisi dosya ve dizin kopyalamaktır. Sol panelde istediğiniz bir dosyayı sağ paneldeki istediğiniz bir yere kopyalamak için, dosya üzerine gelip "F5" tuşuna basmanız yeterlidir. Dosyayı silmek için "F8", karşı tarafa taşımak için "F6" tuşunu kullanınız. Herhangi bir dosyanın içeriğini görüntülemek için ise "F3" tuşu, düzenlemek için "F4" tuşu imdadınıza yetişecektir. Silmek için "F8" tuşunu kullanın.

Tüm bunları öğrenmek ilk bakışta size zor gibi gelebilir, ancak alıştığınızda komut satırından işlem yapmayı terk edeceğinize inanıyoruz.

10.6 DOSYA VE DİZİN HAKLARI

UNIX dosya sisteminde, dosyalar üzerindeki kullanıcı haklarını ayarlamak için başlıca "chown" (sahiplik) ve "chmod" (haklar) olmak üzere iki komut kullanılır. Ancak bu iki komutun alacağı parametreleri hatırda tutmak pek de kolay değildir. 
Örneğin bir dosyanın sahibine okuma ve yazma, grubuna okuma hakkı vermek için 640 hakkını vermelisiniz. Bu rakamı ezberlemek hiç te kolay değildir. Bunun yerine dosya üzerine gelip "F9 > File > cHmod" yolunu izleyip ilgili kutucuklara boşluk çubuğu ile işaretleyin. Aynen Şekil-8'deki gibi.
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Şekil-8: dosya ve dizin haklarının yapılandırması

Dosyaların sahipliklerini değiştirmek içinde yine benzer bir yöntem izliyoruz. "F9 > File > chown" yolu ile menüyü açın. 
Şekil-9'da "Enter" tuşuna basıldığında dosyanın sahibi "mbaser" grubu da "görkem" olacaktır. Eğer süper kullanıcı değilseniz dosyaların sahibini başkası yapamazsınız.
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Şekil-9: Dosya sahipliğini değiştirmek için kullanıcıyı ve gurubu listeden seçebilirsiniz

10.7 LİNKLER

UNIX dosya sisteminin en büyük özelliklerinden birisi de dosya ve dizinlere bağlantıların atılabilmesidir. Örneğin "Amp/WordPer-fect/wpbin" dizini sık ziyaret edilen bir dizinse kendi ev dizinimden buraya bir sembolik bağlantı kurar ve kolayca bu dizine erişirim. 
Bunun için sol panelin yerini bu dizine getirin ve "F9 > File > SymLink" yolunu izleyerek bağlantı menusunu açın. Yapmanız gereken tek şey aşağıdaki satıra bağlantı ismini yazıp "Enter" tuşuna basmak olacaktır. Şekil- 10'da örneği görebilirsiniz.
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Şekil-10: Enter tuşuna basıldığında root kullanıcısı artık tmp/WordPerfect/wpbin dizinine geçmek için sadece “cd ./wp8” yazacaktır

Eğer var olan bir sembolik bağlantıyı düzenlemek istiyorsanız o zaman "F9 > File > edit symlink" yolunu takip edin.

10.8 DOSYALARI BULMAK

Bazen dosyaları kaybederiz, bulmak isteriz. mc size kaybettiğiniz dosyaları geri verebilir. Ayrıca dosyaların içine bakma gibi bir özelliği de vardır. 
Şekil-11'de mbaser kullanıcısının ev dizini ve tüm alt dizinlerindeki tüm dosyaların içerisine bakılarak içinde "neden böyle" yazan dosyaları bulacak. 
"F9 > Command > Find Files"  Dosyanın ismi ya da uzantısını hatırlıyorsanız "Content" kısmı boş kalabilir. Örneğin "pcmag" ile başlayan ve uzantısı "sdw" olan tüm dosyaları bulmak için Filename kısmına "pcmag*.sdw" yazıp "Enter" tuşuna basın.
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Şekil-11 : arama penceresi.

10.9  mc nin ÖZELLİKLERİ

mc aynı zamanda iki ayrı panelde iki dizinin içeriklerinin görüntülemesini sağlar. Ancak aynı anda panellerden sadece biri geçerli yada aktif paneldir (yatay seçim çubuğunun bulunduğu panel). Hemen hemen tüm fonksiyonlar o an geçerli panelde kullanılabilir. Örneğin bazı dosya işlemlerinde (kopyalama, dosya/dizin ismi değiştirme), seçim çubuğunun bulunduğu dizin kaynak, diğer panel hedef  konumundadır. Ancak işlem esnasında bir onaylama penceresi kullanıcıdan onay almak amacıyla görüntülenir.


mc kullanıcı için tanımlanmış kabuğun altında bir alt kabuk şeklinde çalışır. Bu yüzden komut satırında, herhangi bir sistem komutu yazılarak çalıştırıldığı zaman bu alt kabuk altında çalışır. Yazılan herşey komut satırında görülebilir. Yürütülen tüm komutlar, mc’nin çalıstığı kabuğun değil mc’nin kendi komut tarihçesinde tutulur ($HOME/.mc/history  adlı dosyada) 

mc, mouse desteği ile birlikte gelir. mc, bir xterm üzerinde çalıştırıldığı zaman mouse desteği aktive olur . 


Dizin panellerinden birinde bir dosyaya sol tıklandığında, o dosya seçilir. Eğer sağ tıklanırsa işaretlenir (işaretli dosyaya tekrar sağ tıklanırsa, işaret kaldırılır). Dosyaya çift tıklamak, eğer dosya çalıştırılabilir bir dosya yada program ise komutun yürütülmesini ve eğer uzantısı ile bir program ilişkilendirilmiş ise programın dosyayı açmasını veya çalıştırmasını sağlar. 
mc ‘deki bazı komutlar CTRL, ALT, META ile diğer tuşlardan oluşan kombinasyonları gerektirir. Örneğin,
CTRL-x     : control tuşuna basılı tutarak x tuşuna basılacak,

CTRL-x c  : control tuşuna basılı tutarak x tuşuna basılıp her iki tuş bırakıldıktan sonra c tuşuna basılacak demektir.META tuşu olarak adlandırılan tuş çoğunlukla ALT yada COMPOSE  tuşudur. Tuş kombinasyonları, konu içinde değişik başlıklar altında açıklanacaktır. 

Enter        : Eğer komut satırında bir komut varsa işletilir. Yoksa ve eğer seçim çubuğu bir dizinin üzerinde ise dizinin içine girilir. Seçim çubuğunun bir programın üzerinde olması durumunda ise program çalıştırılır. Son olarak çubuk dosya-uzantı dosyasında (extention file) bulunan dosya uzatılarından biriyle uyuşursa, ilgili uygulama çalıştırılır.

CTRL-l     : midnight commander’ın içerdiği tüm bilgilerin tazelenmesini sağlar.


CTRL-x s : işaretli dosyaya sembolik link bağlamaya yarar.


CTRL-x i  : diğer panelin bilgi paneline dönüştürür


CTRL-x q : diğer panelin quick view paneline dönüştürür.


CTRL-o   : Program linux konsolunda  yada xterm altında çalıştırılıyorsa, bir önceki komutun çıktısını ekranda listeler. Tekrar CTRL-o tuşlanarak mc’ye geri dönülebilir.


Link ( CTRL-x l )O anki seçili dosyaya hard-link atar.



Symlink ( CTRL-x s )Seçili dosyaya sembolik link yaratır. Sembolik link, orijinal dosya ismi ile ilişkilendirilen bir referanstır. mc, sembolik link atılmış dosyaları başına “@" işareti getirerek listeler. Linkin bağlı olduğu  orijinal dosya,  mc’nin mini-status-line kısmında görülebilir. Hard Link ‘in yarattığı  karmaşıklıktan kurtulmak için sembolik link kullanmakta fayda vardır.

10.10 DİZİN PANELLERİ
· TAB : Aktif paneli değiştirir. Pasif olan panel aktif panele dönüşür. Seçim çubuğu aktif panelden yenisine geçerek aktif panelde yeralır.


· Insert, CTRL-t : Dosyaları yada dizinleri üzerinde işlem yapmak amacıyla işaretlemek amacıyla kullanılır. İşaretlenmiş dizin (dosya) üzerinde insert (yada CTRL-t) tuşuna tekrar  basılırsa işaret kaldırılır.


· Home : seçim çubuğunu aktif olduğu paneldeki dizinde ilk elemana konumlandırır.


· End : seçim çubuğunu aktif olduğu paneldeki dizinde bir sayfa aşağı kaydırır.


· Next-page: seçim çubuğunu aktif olduğu paneldeki dizinde bir sayfa aşağı kaydırır.


· Prev-page : seçim çubuğunu aktif olduğu paneldeki dizinde bir sayfa aşağı kaydırır.

10.11 MENÜ ÇUBUĞU (MENU BAR) 
Menü çubuğu, F9 tuşuna veya mouse ile ekranın üstüne (mc’nin üst çerçevesi içine) tıklandığı zaman aktif olan ve içeriğinde Left, File, Command, Options, Right adı altında beş adet drop-down menü bulunduran bir satırdır. Sol ve sağ meni sol ve sağ drop-down menünün görüntüsünü değiştirmek için kullanılır. 

File Menu (Dosya Menüsü) 

O an seçilmiş olan dosya ve dosyalar üzerinde çeşitli işlemler yapmaya olanak sağlar. 

Command Menu (Komut Menüsü)

Daha genel olarak, dosya seçimine bağlı olmaksızın , çeşitli komutların çalıştırılmasını sağlar.

Left and Right Menu (Sol ve Sağ Panel Menüleri)

Dizin panellerinin görüntüsü, içeriği, listeleme örüntüsü (pattern-şekil), bu menülerden her panel için ayrı ayrı değiştirilebilir özelleştirilebilir. Menüde,

	  Listing Mode
	Filter                                        

	Quick View
	Network Link

	Info


	FTP Link

	Tree


	Rescan

	Order
	


seçenekleri bulunur.

10.12 Fonksiyon Tuşları kullanımı 
mc, F1—F10 fonksiyon tuşlarını dosya menüsündeki komutlara ulaşmak için klavye kısayolları olarak kullanır. Fonksiyon tuşu desteği olamayan terminallerde, ESC ve arkasından 1-9 rakam tuşları kullanılarak aynı işlev sağlanabilir. Dosya menüsü (File Menu), şu komutları içerir (fonksiyon tuşları parantezler içinde belirtilmiştir). 
	Help (F1)  Tümleşik (Built-in) hypertext yardım görüntüleyiciyi çalıştırır. Yardım içinde, TAB tuşu ile bir sonraki linki seçilebilir ve Enter tuşu ile link takip edilebilir. Yön tuşları ve backspace tuşları metin içinde ileri geri dolaşmayı kolaylaştırır. Yardm içinde tekrar F1’e basılırsa, Yardım tarafından kabul edilebilecek tuşlar kullanılabilir.

	Menu (F2)Kullanıcı menüsünü aktive eder. Kullanıcı menüsü, kullanıcının mc’ye ekstra özellikler eklemesine ve bunlara kolayca ulaşabilmesine olanak sağlar. 

	View (F3, Shift F3) O an seçili dosyanın içeriğini görüntüler. Varsayılan olarak içsel dosya görüntüleyiciyi kullanır. 

	Edit (F4) mcedit içsel editörü çalıştırılır.

	Copy (F5) Varsayılan olarak hedef panel pasif, kaynak aktif panel olarak gösterilen bir onay kutusu açılır. Seçilmiş olan dosya veya işaretlenmiş dosyaları (dizinleri) hedefe kopyalar . Hedef dizin onay kutusunda değiştirilebilir. Kopyalama işlemi esnasında işlem CTRL-C (veya ESC) ile kesilebilir. 

	Remove / Move (F6) Varsayılan hedef panel olarak pasif paneli ve pasif panelin listelediği dizini gösteren bir onay kutusu ile kullanıcı ile etkileşerek aktif paneldeki işaretlenmiş (tagged) veya seçili (currently seleceted) dosyaları, dizinleri hedefe taşır. 

	Mkdir (F7) Bir haberleşme penceresi açarak, belirtilen dizini yaratır.

	Delete (F8) 
Seçim çubuğunun belirttiği yada işaretlenmiş olan dosyaları siler. Silme işlemi ESC veya CTRL-C tuşları ile durdurulabilir.

	Quit ( F10, Shift F10)Midnight Commander dan çıkış için kullanılır. F10 tuşu mc’den çıkıldığında kullanıcının aktif panelin gösterdiği dizinde kalmasını, Shift F10 tuşu ise kullanıcının mc  ile son ziyaret edilmiş dizine  değil, mc’nin içindeyken başlatıldığı dizine dönülmesini sağlar.


10.13 COMMAND MENÜSÜ
· Directory Tree (Dizin ağaç görüntüsü) komutu, dizinlerin ağaç yapısı şeklinde listelenmesini sağlar. 

· Find File komutu, belirli bir dosyayı arayıp bulmaya izin verir. Swap Panels komutu ise iki dizin panelinin içeriklerini birbiri ile değiştirir. 

· Switch Panels on/off komutu ise son yürütülen komutun çıktısının görülebilmesi için mc yi gizler. Mc yi tekrar geri getirmek için Ctrl-o  tuşları kullanılmalıdır. 

· Compare Directories komutu (CTRL-x d) ise iki paneldeki dizinlerin içeriklerinin karşılaştırır ve farklı olan dosya ve dizinlerin isimleri işaretlenir. Bu dosyalar Copy (F5) komutu ile kopyalanabilir ve  her iki panel böylece senkronize edilmiş olur.

Üç adet karşılaştırma metodu vardır

quick, 
thorough 
size-only metod. 

quick metod, sadece dosya büyüklüğüne ve dosya tarihine göre karşılaştırma yaparken thorough metod iki dosya üzerinde byte byte karşılaştırma yapar.Size-only sistem komutu ise adından da anlaşılabileceği gibi sadece dosyanın büyüklüğüne göre kıyaslama yapar ve diğer dosya özniteliklerini (attributes) ve bunlardaki değişiklikleri dikkate almaz.. 

· Command history komutu, kullanılmış olan komutların bir listesini ekrana getirir, seçilen komut komut satırına kopyalanır ve ayrıca ALT-p yada ALT-n tuşları ile bu listeye erişilebilir. 

· Find File:  Find File komutu, arama bulma işlemi için kullanıcıya, aramaya hangi dizinden itibaren başlanılacağını, hangi dosyanın aranacağını sorar dizinin adı yazılabilir veya Tree butonunan basılarak dizin ağaç yapısından seçilebilir.


 

